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User Guide Basics

Basics

Log in to the BlackBerry Web Desktop
Manager

Before you begin: To perform this task, your administrator must provide you with a user name, a password, and, if
necessary, a domain name.

1. Type your user name and password.
2. Ifnecessary, type a domain name.

3. Click Login.

Connect your device to your computer using
a USB cable

1. Connect the large end of the USB cable to a USB port on your computer.
2. Connect the small end of the USB cable to the USB port on the side of your BlackBerry device.

3. Onyour computer, if the Device Security Password field appears, type your device password. Click OK.

Prerequisites: Bluetooth connections

e Your BlackBerry device must be running BlackBerry Device Software 4.1 or later.

e Your computer must be running Windows XP SP 2 or later. For more information about the Bluetooth adapters that are
supported in Windows XP SP 2 or later, visit www.blackberry.com/support.


http://www.blackberry.com/support
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e Your computer must be paired with your BlackBerry device. For more information about pairing, click Help on your
device.

Connect your device to your computer using
Bluetooth technology

On the Advanced Settings tab, click Troubleshooting.
Click View information.

Select the Enable Bluetooth® support check box.

Click Configure Bluetooth.

Click Add.

In the Bluetooth devices list, click your BlackBerry device.
Click OK.

Click OK.

© N O Ok~ W N

About browser compatibility

Windows Internet Explorer 7 or later provides the optimal support for BlackBerry Web Desktop Manager features.

The following browsers are also compatible with BlackBerry Web Desktop Manager, but with limited support for features:
e Mozilla Firefox 3.5

e Safari4 for Mac

e Google Chrome

Depending on the browser that you are using, BlackBerry Web Desktop Manager might not recognize your BlackBerry

device, and you might not be able to activate your device over the wireless network, back up and restore your device data,
or add or update device applications.
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Create an activation password

You must create an enterprise activation password to activate your BlackBerry device over the wireless network. If your
device is already activated, you can follow these steps to create a new activation password. For more information, contact
your administrator.

1.

2
3.
4

On the Home tab, click Create an Enterprise Activation Password.
In the Enterprise activation password field, type a password.
In the Confirm password field, type the password again.

Click Set the enterprise activation password.

Change your device password from the
BlackBerry Web Desktop Manager

If your BlackBerry device has been misplaced and you might be able to recover it, you can use the BlackBerry Web
Desktop Manager to change your device password and lock your device to help secure your device data. Depending on
your administrator, this feature might not be available.

1.

2
3
4.
5

On the Home tab, click Secure a Lost Device.

Click Specify new device password and lock device.

In the Device password field, type your new device password.
In the Confirm password field, type your new password again.

Click Specify new device password and lock device.
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Delete all device data and deactivate
SEervices

If your BlackBerry device has been misplaced or stolen, you can delete your device data and deactivate all services, such
as email messaging and data synchronization. Depending on your administrator, this feature might not be available.

1.  Onthe Home tab, click Secure a Lost Device.
2. Click Delete all device data and disable device.
3.  Click Yes.

Note: If you recover your device, you can activate your services again by either connecting your device to your computer
using a USB cable or by creating an activation password so that you can activate your device over the wireless network.

Troubleshooting: Basics

My computer cannot detect my device

Try the following actions:
e \Verify that your BlackBerry device is connected to your computer.
e |fyou are trying to connect your device to your computer using a USB cable, verify that the USB cable is not damaged.

e [fyou are trying to connect your device to your computer using Bluetooth technology, verify that your device is within
range of your computer (a typical range is approximately 10 meters).

e Turn off synchronization programs or antivirus programs temporarily.
e \Verify that you are not running software that scans the communications ports on your computer.

e Onthe Advanced Settings tab, in the Troubleshooting section, if the Detect a BlackBerry device with Application
Loader link appears, your administrator might have made BlackBerry Device Software available for you to install. Click
the link and complete the instructions on the screen.
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| cannot access the features of the BlackBerry Web
Desktop Manager

If the features of the BlackBerry Web Desktop Manager are unavailable because the necessary controls are not installed,
try performing the following actions:

e See the system requirements for the BlackBerry Web Desktop Manager in the BlackBerry Enterprise Server Installation
and Configuration Guide. To download this guide, visit www.blackberry.com/go/serverdocs/.

e Contact your administrator.


http://www.blackberry.com/go/serverdocs/
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Backup and restore

Back up device data

1. Connect your BlackBerry device to your computer.
2. Onthe Backup and Restore tab, perform one of the following actions:
e Toback up all your device data, click Back up.

e To back up specific device data, click Advanced. In the Device Databases section, click a database. Click the
Left Arrow icon. On the File menu, click Save As.

e [fyour device contains on-board device memory, to back up files that you saved to your device, verify that mass
storage mode is turned on. Click Configure Backup Options. Select the Back up on-board device memory check
box. Click Save. Click Back Up and Restore Now to continue backing up device data.

Schedule automatic backups of device data

1. Connect your BlackBerry device to your computer.
2. Onthe Backup and Restore tab, click Configure Backup Options.
3. Select the Automatically back up my device check box.
4.  Set how often automatic backup should occur.
5. Perform one of the following actions:
e |fyour device contains on-board device memory, to back up files that you saved to your device, verify that mass
storage mode is turned on. Select the Back up on-board device memory check box.
e Toback up all device data, select the Backup all device application data option.
e Toexclude email messages or organizer data, select the Backup all device application data, except for option.
Specify the type of data to exclude.
6.  Click Save.

10
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Restore device data

1. Connect your BlackBerry® device to your computer.
2. Onthe Backup and Restore tab, perform one of the following actions:
e Torestore all the device data in a backup file, click Restore. Double-click a backup (.ipd) file.

e Torestore specific device data from a backup file, click Advanced. On the File menu, click Open. Double-click a
backup (.ipd) file. In the Desktop File Databases section, click a database. Click the Right Arrow icon.

Troubleshooting: Backup and restore

| cannot restore some device data

Try the following actions:

e \Verify that the database that you are trying to restore does not appear dimmed in the Device Databases section. If the
database appears dimmed and the Right Arrow icon is not available, your BlackBerry device might be configured for
wireless synchronization, wireless backup might be turned on, or the database might be read-only. For more
information, contact your administrator.

e \Verify that your device has enough available memory to store the database. The amount of memory that appears beside
the database in the Desktop File Databases section might differ from the amount of memory that is required to store
the database on your device. If the application memory on your device is low, consider deleting unused applications,
old data, or old messages from your device.

Error messages: Backup and restore

The Backup This message appears if you log in to the BlackBerry Web Desktop Manager from a computer
functionality is not that your administrator has restricted from performing backup and restore functions. For more
available at your information, contact your administrator.

current location.

This function is no This message appears if your administrator has changed your permissions since you logged in to
longer available to the BlackBerry Web Desktop Manager. For more information, contact your administrator.

11
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you. No changes
have been made.
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Email settings

Email messages settings

Stop forwarding email messages to your device

1. Onthe Email Settings tab, clear the Redirect incoming email messages to the device check box.

2.  Click Save.

Add a signature

1.  Onthe Email Settings tab, in the Signature box, type a signature.
2. Click Save.

Delete your signature

1. Onthe Email Settings tab, in the Signature box, delete the signature.

2. Click Save.

Store messages sent from your device on your
messaging server

Email settings

1. Onthe Email Settings tab, select the Save copy in Sent folder when sending an email message from the

BlackBerry® device check box.
2. Click Save.

13
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Add contacts to your device from your email message
folders

You can add private or corporate contact folders that appear in the email application on your computer to the contact list
on your BlackBerry device. The corporate, or public, contact folders are published by your administrator.

1.  Onthe Email Settings tab, click Contact Folders or Published Contact Databases.
2. Ifyou are using a Microsoft Outlook email account, perform any of the following actions:

¢ |nthe Published public contact folders section, select the check box beside one or more corporate contact
folders that you want to add to the contact list on your device.

¢ Inthe Private contact folders section, select the check box beside one or more personal contact folders that you
want to add to the contact list on your device.

e |nthe Default private contact folder section, in the Default contact folder drop-down list, click a personal folder
to synchronize with your device. When you add a new contact on your device, it is added to this folder.

3. Ifyou are using an IBM® Lotus Notes® email account, select the contact databases that you want to add to the
contact list on your device.

4.  Click Save.

Forward messages from a specific email message
folder to your device

1.  Onthe Email Settings tab, click Redirection Folders.
2. Perform one of the following actions:

e |fyour BlackBerry device is associated with a Microsoft Outlook email account, to receive email messages from
your inbox to your device, click Inbox.

e Toreceive email messages from your inbox and sent items folder to your device, click Inbox and Sent Items only.

e To specify additional email message folders, including your inbox and sent items folder, click Selected folders.
Select the check box beside one or more folders.

3. Click Save.

14
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Email settings

Delivery status for email messages and organizer data

If your BlackBerry device is connected to your computer, from the Advanced Settings tab, you can view the service
statistics for your email messages and organizer data items.

Messages
forwarded

Messages sent

Messages pending

Messages expired

Messages filtered

This field displays the number of email messages and organizer data items that the BlackBerry
Enterprise Server has forwarded to your device.

This field displays the number of email messages and organizer data items that you have sent
from your device.

This field displays the number of email messages and organizer data items that the BlackBerry
Enterprise Server has not yet forwarded to your device. If your device is not connected to the
wireless network, the BlackBerry Enterprise Server queues email messages and organizer data
items for up to 7 days and forwards them when your device is connected to the wireless network
again.

This field displays the number of email messages and organizer data items that the BlackBerry
Enterprise Server could not forward to your device within 7 days. These email messages and
organizer data items remain in the email application on your computer.

This field displays the number of email messages that the BlackBerry Enterprise Server did not
forward to your device because your email message filters prevented redirection or because your
device was connected to your computer.

Add contacts from your organization's contact list to

your device

You can add private or corporate contact folders that appear in the email application on your computer to the contact list
on your BlackBerry device. The corporate, or public, contact folders are published by your administrator.

1.  Onthe Email Settings tab, click Contact Folders or Published Contact Databases.

2. Ifyou are using a Microsoft Outlook email account, perform any of the following actions:

¢ |nthe Published public contact folders section, select the check box beside one or more corporate contact
folders that you want to add to the contact list on your device.

e |nthe Private contact folders section, select the check box beside one or more personal contact folders that you
want to add to the contact list on your device.

¢ |nthe Default private contact folder section, in the Default contact folder drop-down list, click a personal folder
to synchronize with your device. When you add a new contact on your device, it is added to this folder.

15
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3.

4.

If you are using an IBM® Lotus Notes® email account, select the contact databases that you want to add to the
contact list on your device.

Click Save.

Email message filters

About email message filters

You can create email message filters to specify which email messages are forwarded to your BlackBerry device and which
remain in the email application on your computer.

Email message filters are applied to email messages based on the order in which they appear in your list of email message
filters. If you create multiple email message filters that could apply to the same email message, you must decide which one
should be applied first by placing that filter higher in the list.

Create an email message filter

1
2
3.
4

o

On the Email Settings tab, click Email Filter Settings.
Click Add new email message filter.
Set the email message filter options.

To select contacts or distribution lists from your organization's contact list, click the Import list icon beside the From
or Sent to fields.

Click Add New Filter.
Click Save.

Options for email message filters

Filter name: Type a unique name for the new filter.

From: Specify one or more contacts or email addresses that the email message filter should search for

16

in the From field of email messages. Separate multiple contacts or email addresses with a
semicolon (;). To specify that the email message filter should search for all email addresses that
contain specific text, type the text and use an asterisk (*) as a wildcard character to represent
the rest of the email address.
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Sent to:

Subject:

Body:

Sent directly to me:

CC: to me:

BCC: to me:

Importance:
Sensitivity:

Forward messages
to the device:

Do not forward
messages to the
device:

Email settings

Specify one or more contacts or email addresses that the email message filter should search for
in the Sent To field of email messages. Separate multiple contacts or email addresses with a
semicolon (;). To specify that the email message filter should search for all email addresses that
contain specific text, type the text and use an asterisk (*) as a wildcard character to represent
the rest of the email address.

Type the text that the email message filter should search for in the Subject field of email
messages.

Type the text that the email message filter should search for in the body of email messages.

Set whether the email message filter applies to email messages that include your email address
in the To field.

Set whether the email message filter applies to email messages that include your email address
in the CC field.

Set whether the email message filter applies to email messages that include your email address
in the BCC field.

Set the importance level of email messages that the email message filter applies to.
Set the sensitivity level of email messages that the email message filter applies to.

Select this option to forward email messages that the email message filter applies to your
BlackBerry device. Specify whether email messages are forwarded with high importance or with
the email message header only.

Select this option to prevent email messages that the email message filter applies to from being
forwarded to your device.

Add a contact from your organization's contact list to
an email message filter

You can import contacts from your organization's contact list into an email message filter.

1.  When creating or changing an email message filter, click the Import list icon beside the From or Sent to fields.

2. Inthe Search Users section, perform one of the following actions:

¢ |nthe Messaging server display name field, type the user display name for the contact on your organization's
messaging server.

¢ Inthe Email address field, type part or all of the email address for the contact.

3. Click Search.

17
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4. Inthe search results, select the check box beside the contact.

5. Click Next to continue creating or changing your email message filter.

Change an email message filter

1 On the Email Settings tab, click Email Filter Settings.
2 Click an email message filter.

3. Change the email message filter options.

4

To select contacts or distribution lists from your organization's contact list, click the Import list icon beside the From
or Sent to fields.

Click Update Filter.
6. Click Save.

o

Change the order of email message filters

1. Onthe Email Settings tab, click Email Filter Settings.
2. Click the Up Arrow icon or the Down Arrow icon.
3. Click Save.

Turn off an email message filter

1.  Onthe Email Settings tab, click Email Filter Settings.
2. Click the checkmark icon beside an email message filter.

3.  Click Save.

Delete an email message filter

1. Onthe Email Settings tab, click Email Filter Settings.
2. Click the minus sign icon beside an email message filter.

3.  Click Save.

18
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Save all email message filters

1. Onthe Email Settings tab, click Email Filter Settings.
2. Click Save Filters.

Open a saved email message filter

1 On the Email Settings tab, click Email Filter Settings.
2 Click Load Filters.

3. Click an email message filter (.rfi) file.

4

Click Open.

Troubleshooting: Email settings

| cannot send or receive email messages on my device

Try performing the following actions:
e Verify that your BlackBerry device is connected to the wireless network.

e Verify that email message forwarding is turned on and that you have selected all the email message folders, including
your inbox folder, that you want to receive email messages from.

e [fyou have generated a new encryption key, connect your device to your computer to share the encryption key.

e \Verify that your email profile options are correct. For more information, contact your administrator.

19
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Switch devices 4

About switching devices

You can use the switch device wizard to transfer data and services from your current BlackBerry® device to a new
BlackBerry device.

The switch device wizard is designed to transfer supported organizer data, messages, third-party applications, and
BlackBerry Enterprise Server connection options from your current device to your new device. The switch device wizard
also starts the activation process for your new device. During the activation process, BlackBerry services, such as email
reconciliation, are transferred to your new device.

Switch devices

1.  Connect your new BlackBerry device to your computer, or connect both your current device and new device to your
computer.

2. Click Yes - Switch my BlackBerry services to this device.
3. Click Yes - Transfer the data.

4.  Complete the instructions on the screen.

After you finish: Do not disconnect your device from your computer until your device data and services have been
switched and the activation process on your new device is complete. The process is complete when the Change devices
screen appears on your computer.

20
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Legal notice

©2012 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, and related trademarks,
names, and logos are the property of Research In Motion Limited and are registered and/or used in the U.S. and countries
around the world.

Mac and Safari are trademarks of Apple Inc. Bluetooth is a trademark of Bluetooth SIG. Google Chrome is a trademark of
Google Inc. IBM and Lotus Notes are trademarks of International Business Machines Corporation. Microsoft, Outlook and
Windows are trademarks of Microsoft Corporation. Mozilla and Firefox are trademarks of Mozilla Foundation. All other
trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or
made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without
condition, endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated
companies ("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or
omissions in this documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this
documentation may describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically
change information that is contained in this documentation; however, RIM makes no commitment to provide any such
changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or
services including components and content such as content protected by copyright and/or third-party websites
(collectively the "Third Party Products and Services"). RIM does not control, and is not responsible for, any Third Party
Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility,
performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The
inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by RIM of
the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR
WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE
QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A
COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE
OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR
PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND
CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE
DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE
HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM
THAT IS THE SUBJECT OF THE CLAIM.
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TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE
LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-
PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT,
CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES
FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA,
FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN
CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF RIM PRODUCTS OR
SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF
COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT
SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER
OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY
LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF
THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL
BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY
CONTAINED HEREIN; AND (B) TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS,
SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME
SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM
HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that
your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer
Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for
availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with
RIM's products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid
infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party
Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring
them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any
Third Party Products and Services that are provided with RIM's products and services are provided as a convenience to you
and are provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties
of any kind by RIM and RIM assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and
Services shall be governed by and subject to you agreeing to the terms of separate licenses and other agreements
applicable thereto with third parties, except to the extent expressly covered by a license or other agreement with RIM.

Certain features outlined in this documentation require a minimum version of BlackBerry Enterprise Server, BlackBerry
Desktop Software, and/or BlackBerry Device Software.
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The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable
thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR
WARRANTIES PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS
DOCUMENTATION.

Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada

Research In Motion UK Limited
200 Bath Road

Slough, Berkshire SL1 3XE
United Kingdom

Published in Canada
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